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About me

Doctorante en Economie a PSE en 3éme année

Champs de recherche: économie de la famille, de l'éducation, du travail

Pour me contacter, si vous avez des questions ou envie/besoin de parler:
florentine.oliveira@psemail.eu

Campus Jourdan, Bureau R4-54
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Objectifs du cours

e Se familiariser avec

o les techniques @économétriques de base
o la recherche en économie empirique

e Apprendre le language de programmation R

——> pour pouvoir réaliser votre mémoire !
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Roadmap

Semestre 1

1. Séance 1 (aujourd'hui): Rappels de Rr
2. Séance 2 (12/11/2024): T EX et R Markdown
3. Séance 3 (19/12/2024): Régressions Linéaires et Causalité

Semestre 2

1. Séance 4 (04/02/2025): Variables de Controle et Matching

2. Séance 5 (18/02/2025): Méthode des Variables Instrumentales
3. Séance 6 (11/03/2025): Méthode des Doubles-Différences (DiD)
4. Séance 7 (25/03/2025): Regression Discontinuity Design (RDD)

5. Séance 8 (08/04/2025): Q & A

4 | 67



Validation du cours

DM

Objectif: manipulation de données sur R, intuition, quelques régressions

A faire seul(e) ou a deux

A rendre pour le 10 Janvier 23h59

Memoire
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Cette seance

1. La recherche en économie empirique
2. R: Rappels

2.1. Définition, usages, interface

2.2. Projet R

2.3. Importer des donnees

2.4. Manipulation des données avec dplyr
2.5. Visualisation des données avec ggplot
2.6. Maps
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1. La recherche en eéconomie empirique

Qu'est-ce que la recherche en économie empirique?

e Répondre a des questions de recherche pour apprendre sur les comportements humains, l'efficacité des poliques
publiques, ...
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1. La recherche en économie empirique

Qu'est-ce que la recherche en économie empirique?

e Répondre a des questions de recherche pour apprendre sur les comportements humains, l'efficacité des poliques
publiques, ...

(¢]

Quel est l'effet des bourses de scolarité sur la réussite scolaire?

Quel est l'effet d'un allongement de la durée du congé parental sur la participation au marché du travail des meres?
Quelle est l'ampleur de la discrimination dans le processus de recrutement?

Quel est l'effet d'un assouplissement des conditions d'eligibilité a l'assurance chomage sur l'emploi?

Quel est l'effet de la pollution atmospheérique sur la productivite?

Quel est le role des médias sur le comportement de vote?

Quel est l'effet de la densité de population sur les salaires?
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1. La recherche en économie empirique

Qu'est-ce que la recherche en économie empirique?

e Répondre a des questions de recherche pour apprendre sur les comportements humains, l'efficacité des poliques
publiques, ...

o Grande diversite des champs de recherche: éducation, travail, famille, environnement, macroeconomie, politique,
migration, genre, urban, crime, économie historique, ...

e .. en utilisant des techniques statistiques rigoureuses (= @conometrie) ...
e .. Une stratégie/un cadre qui nous permet d'identifier un effet causal...

e .. etdes données!

R est un logiciel qui permet de réaliser ces analyses descriptives et empiriques.
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2. B: rappels




2. B rappels

2.1. Déefinition, usages, interface

e D'apres le site internet de R : R is a free software environment for statistical computing and graphics.
o un logiciel (interface R studio)
o un language de programmation
e R est gratuit et en open source
o donc tres utilise dans les milieux académique et institutionnel
 Logiciel tres polyvalent
o statistiques decriptives, analyses économetriques, analyse de données spaciales, ML, Rmarkdown

o Compétence valorisée et de plus en plus recherchée (public & privé)
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https://r4stats.com/articles/popularity/

2. B rappels

2.1. Déefinition, usages, interface

& RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help D C 3 91xmm & Jeu. 20 juin 22:49

@ children-of-the-revolution - main - RStudio

- .- M & A Gotofile/function ~ | 8 - Addins - EJ children-of-the-revolution ~

2 cleaning.R =) children-of-the-revolution-clean.R... <) slides_15mn.Rmd Environment  History Connections Git  Tutorial
@ A B Knit on Save ® | /knit -~ % - %8 - 4 § B Run- ~ & [ & ImportDataset - € 985 MiB - & =Lsty |G-
Source  Visual Outline R ~ ' #, Global Environment ~ Q

LR ® fqp_2014_2015 25173 obs. of 64 variables

full_sample %% ® full_ri_r2 44534 obs. of 93 variables
filter(birth_year > 1944) %% ® full_sample 119190 obs. of 93 variables
group_by(cohort) %% ® h_na Large 1m (14 elements, 18.7
summarise(mean_family_size = weighted.mean(family_size, POIDS, na.rm = T)) %% ®h.ra Large 1m (15 elements, 13.8

ungroup() %>% ®

ggplot(aes(x = cohort, y = mean_family_size, group = 1)) + hiraz Large Im (15 elements, 13.8
geom_point(size=1) + ®h_re Large 1m (14 elements, 13.7
geom_line(size = 0.7) + ® high_ses Large 1m (15 elements, 18.5
geom_vline(xintercept = "1955-1959", color , size=1) + ® households ST e, i R s

geom_vline(xintercept = "1975-1979", color , size=1) + -
scale_x_discrete(name = "Birth cohort") + ® households_ra.. 28133 obs. of 114 variables

scale_y_continuous(name = "Number of children") + ® households_ra.. 9358 obs. of 124 variables

scale_color_manual(values = mycolors) ® households_un.. 51905 obs. of 106 variables

theme_bw() + .

theneCtext=element text(family="Palatino™, ® households_un.. 27501 obs. of 99 variables
plot.title = element_text(size = 8, margin=margin(0,0,10,0)), ® n5 Large 1m (14 elements, 18.7
axis.title.x = element_text(size = 13, margin = margin(t = 10, r = 0, b = -
axis.title.y = element_text(size = 13, margin = margin(t = @, r = 10, b
axis.text.x = element_text(size=12, angle =45, vjust = 1, hjust = 1), © Zoom | & Export - <
axis.text.y = element_text(size=12)) +

xlab("") +

ylab("")

" SPEEBBBRBRPLOLPLPOSEEN

Files = Plots Packages Help Viewer Presentation

Q

601:15 (€ Chunk 14: strategy 1 regression full sample R Markdown

Console  Terminal Background Jobs

@ R4.2.2 - ~/Desktop/Children of the Revolution/Work/children-of-the-revolution/ = /

+ scaie_y_continuous(name = Numper ot cniiaren ) +

#scale_color_manual(values = mycolors) +

theme_bw() +

theme(text=element_text(family="Palatino"),
plot.title = element_text(size = 8, margin=margin(0,0,10,0)),
axis.title.x = element_text(size = 13, margin = margin(t = 10, r = @, b
axis.title.y = element_text(size = 13, margin = margin(t = @, r = 10, b =
axis.text.x = element_text(size=12, angle =45, vjust = 1, hjust = 1),
axis.text.y = element_text(size=12)) +

xlab("") +

ylab("")

Number of children

VOV o+ + o+ 4+ 4+ o+ o+ + o+

Birth cohort




2. B rappels

2.2. Projet R

Les projets R permettent une meilleure organisation de votre travail.

Pratiques de la recherche en économie Création d'un prOjet R:

— lecture_1 e Dans R-Studio

—‘D lecture_1.Rproj C -
o Fichier — Nouveau projet

- Data

— Scripts

I—e lecture_1.R

Output

Figures

— Tables

— lecture_2
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Application: créer votre projet |§

Pratiques de 1a recherche en économie e Créer un projet R pour la Lecture 1 en respectant cette

structure
I— lecture_1 e Créer un nouveau script R, enregistré dans le dossier

lecture_T
lecture_1.Rproj

Data

Scripts

lecture_1.R

Output

Figures

Tables
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2. B rappels

2.3. Importer des donnéees

Format .csv:

e read.csv() OU read.cvs2() avec l'argument sep = ';'

Formats .dta (stata), .sas7bdat (sas): package haven (nb: haven estinclus dans tidyverse)
e .dta : read dta()

e .sas7dbat : read_sas()

Format .xls ou .xlsx (Excel): package readxl

e read_excel()
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2. B rappels

2.3. Importer des donnéees

Format .rds: format de données le moins lourd et optimal pour travailler sur R, surtout quand les bases de données sont tres
volumineuses

e readRDS()

Conseil: a la fin du script de cleaning, enregistrer le ou les data.frames nettoyés en format .Rps avec la fonction saveRDS() et
importer ces données nettoyées dans le script sur lequel vous ferez toutes vos analyses.
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2. B rappels

2.4. Manipulation des données avec dplyr

Principal package pour la manipulation de données : dplyr

data.frame %>% function(your action)
—v—
pipe
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2. B rappels

2.4. Manipulation des données avec dplyr
Principal package pour la manipulation de données : dplyr

data.frame %>% function(your action)
—v—
pipe

Principales fonctions

e mutate():créer ou modifier des variables

e summarise():résume les données par des statistiques descriptives

e filter():conserve ou supprime les lignes

e group_by(): permet de grouper des observations entre elles

e select():conserve ou supprime des colonnes

e arrange():ordonne les observations par rapport aux valeurs d'une colonne
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2. B rappels

2.4. Manipulation des données avec dplyr

Opérateurs
Opérateur arithmeétiques Description Opérateur logiques Description
+ | - Addition / Soustraction </ > Strictement inférieur / supérieur a
x [/ Multiplication / Division <=/ > = Supérieur / inférieur ou égal a
A Exposant - - Egal &
I = Different de
X %in% c(1,6) x dans {1,6}
X &y Trety
x |y Trouy
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Application : Titanic

Ce jeu de données fournit des informations sur le sort des passagers du paquebot « Titanic », resumeées en fonction du statut
économique (class), du sexe, de l'age et de la survie.

titanic = as.data.frame(Titanic)

head(titanic)

H# Class Sex Age Survived Freq
H# 1 1st Male Child No 0
Bt 2 2nd Male Child No ©
Bt 3 3rd Male Child No 35
H# 4 Crew Male Child No 0
H# 5 1st Female Child No 0
H# 6 2nd Female Child No 0
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Application : Titanic

1) Calculer le taux de survie par classe, par sexe, et par age

2) Créer une variable passenger quivaut1si l'individu n'est pas un membre d'équipage (crew), 0 si c'est un membre
d'équipage

3) Créer une table qui résume, pour les adultes uniquement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant
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Solution : Titanic

1) Calculer le taux de survie par classe, par sexe, et par age

titanic %>%
group_by(Class) %>%
summarise(tx_survie = sum(Freq[Survived H: "Yes"])/sum(Freq)) %>%

ungroup()
Bt # A tibble: 4 x 2
H# Class tx_survie
Bt <fct> <dbl>
Bt 1 1st 0.625
Bt 2 2nd 0.414
Bt 3 3rd ©.252
Bt 4 Crew 0.240
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Solution : Titanic

1) Calculer le taux de survie par classe, par sexe, et par age

titanic %>%
group_by(Class) %>%
summarise(tx_survie = sum(Freq[Survived H: "Yes"])/sum(Freq)) %>%

ungroup()
Bt # A tibble: 4 x 2
H# Class tx_survie
Bt <fct> <dbl>
Bt 1 1st 0.625
Bt 2 2nd 0.414
Bt 3 3rd ©.252
Bt 4 Crew 0.240
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Solution : Titanic

1) Calculer le taux de survie par classe, par sexe, et par age

titanic %>%
group_by(Sex) %>%
summarise(tx_survie = sum(Freq[Survived H: "Yes"])/sum(Freq)) %>%

ungroup()
Bt # A tibble: 2 x 2
H# Sex tx_survie
Bt <fct> <dbl>
Bt 1 Male 0.212
H# 2 Female 0.732
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Solution : Titanic

1) Calculer le taux de survie par classe, par sexe, et par age

titanic %>%
group_by(Age) %>%
summarise(tx_survie = sum(Freq[Survived H: "Yes"])/sum(Freq)) %>%
ungroup()

# A tibble: 2 x 2
Age tx_survie

TEEETE

<fct> <dbl>
1 Child 0.523
2 Adult 0.313

23 | 67



Solution : Titanic

2) Créer une variable passenger quivaut1sil'individu n'est pas un membre d'équipage (crew), 0 si c'est un membre
d'équipage

# Solution 1
titanic %>%
mutate(passenger

ifelse(Class Ht "Crew", 1, 0))

# Solution 2
titanic %>%
mutate(passenger = case_when(Class Ht "Crew" ~ 1,

Class H: "Crew" ~ 0))

Conseil: utiliser case_when quand il y a plus d'une condition.
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Solution : Titanic

3) Créer une table qui résume, pour les adultes uniquement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant

titanic %>%
filter(Age H: "Adult") %>%
group_by(Class, Sex) %>%
summarise(tx_survie = sum(Freq[Survived f= "Yes"]) / sum(Freq)) %>%
arrange(desc(tx_survie))
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Solution : Titanic

3) Créer une table qui résume, pour les adultes uniquement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant

titanic %>%
filter(Age = "Adult") %>%
group_by(Class, Sex) %>%
summarise(tx_survie = sum(Freq[Survived = "Yes"]) / sum(Freq)) %>%
arrange(desc(tx_survie))
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Solution : Titanic

3) Créer une table qui résume, pour les adultes uniquement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant

titanic %>%
filter(Age = "Adult") %>%
group_by(Class, Sex) %>%
summarise(tx_survie = sum(Freq[Survived = "Yes"]) / sum(Freq)) %>%
arrange(desc(tx_survie))
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Solution : Titanic

3) Créer une table qui résume, pour les adultes uniqguement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant

titanic %>%
filter(Age = "Adult") %>%
group_by(Class, Sex) %>%
summarise(tx_survie = sum(Freq[Survived = "Yes"]) / sum(Freq)) %>%
arrange(desc(tx_survie))
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Solution : Titanic

3) Créer une table qui résume, pour les adultes uniquement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant

titanic %>%
filter(Age = "Adult") %>%
group_by(Class, Sex) %>%
summarise(tx_survie = sum(Freq[Survived = "Yes"]) / sum(Freq)) %>%
arrange(desc(tx_survie))

H # A tibble: 8 x 3

#H # Groups: Class [4]

#H  Class Sex tx_survie
Ht <fct> <fct> <dbl>
#H 1 1st Female 0.972

#H 2 Crew Female 0.870

#H 3 2nd Female 0.860

#H 4 3rd Female 0.461

#H 5 1st Male 0.326

#H 6 Crew Male 0.223

#H 7 3rd Male 0.162

#H 8 2nd Male 0.0833
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2. B rappels

2.4. Manipulation des données avec dplyr

ERNEE EEEE
A 1 A T
B 2 + B F
C 3 D T

|
-~

e Tres souvent, les donnees necessaires a l'analyse sont issues de plusieurs sources
e Joindre deux tables de données peut permettre d'ajouter

o des variables supplémentaires
o des observations supplémentaires

e l'ajout de variables peut se faire sur la base:

o de la position des observations dans les deux jeux de données: binding joints
o relativement aux valeurs d'une ou plusieurs autres colonnes, les clés: mutating joints
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2. B rappels

2.4. Manipulation des données avec dplyr

Binding joints
Binding Rows
A 1 A T
B 2 ~+ B F —_
C 3 D T
| x1 | x2 | x3 | bind_rows(a, b):dans une jointure de lignes, les colonnes sont associées a leur nom et
2 s toute colonne manquante est remplacée par NA.
B NA
c 3 NA
A NA T
B NA F
D NA T
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2. B rappels

2.4. Manipulation des données avec dplyr

Binding joints
Binding Columns
A 1 A T
B 2 + B F —
C 3 D T
L x| 2 | x1 | X3 | bind_cols(a, b):dans une jointure de colonnes, les lignes sont mises en correspondance
A 1 A T ) ..
B 2 B F en fonction de leur position
C 3 D T
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2. B rappels

2.4. Manipulation des données avec dplyr

Mutating joints

Left-joint

BT R
A 1 A T
B 2 + B F
.

C 3 D

. x1 | x2 | x3 | left_join(a, b, by = "x1"): pour chaque ligne de a on a ajouté les colonnes de b pour
& L I lesquelles la valeur de la clé x1 est la méme
B 2 F
c 3 NA
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2. B rappels

2.4. Manipulation des données avec dplyr

Mutating joints

Right-joint
k2 P Ton
A 1 A T
B 2 ~+ B F

T

C 3 D

| x1 | x3 | x2 right_join(a, b, by = "x1"): pour chaque ligne de b on a ajouté les colonnes de a pour
4 L) L lesquelles la valeur de la clé x1 est la méme
B F 2
D T NA
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2. B rappels

2.4. Manipulation des données avec dplyr

Mutating joints

Inner-joint

BT R
A 1 A T
B 2 + B F
.

C 3 D

x| x2 | x3 | inner_join(a, b, by = "x1"):seules les lignes présentes a la fois dans a et b sont jointes
A 1 i
B 2 F
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2. B rappels

2.4. Manipulation des données avec dplyr

Mutating joints
Full-joint
A 1 A T
B 2 + B F —
C 3 D T
| xt | x2 | x3 | full_join(a, b, by = "x1"):toutes les lignes de a et toutes les lignes de b sont jointes
& L U (avec des NA ajoutés si nécessaire) méme si elles sont absentes de l'autre table
B 2 F
C 3 NA
D NA T
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2. B rappels

2.4. Manipulation des données avec dplyr

Formats wide et long

Pour rassembler des colonnes et passer en format long: pivot_longer

sudont |1 e N e
A 137 12.4 A | L1 137
B 105 141 — B [ 05
c 16.2 15.8 c I -
A L2 12.4
B L2 14.1
c L2 15.8
b = pivot_longer(a, cols = 2:3, names_to = "grade", values_to = "mean")
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2. B rappels

2.4. Manipulation des données avec dplyr

Formats wide et long

Pour disperser des lignes et obtenir un format wide: pivot_wider

Cstucent _grace  sublect _mean | Cstucent | rade _statsics
L1 - L1

A 12.3 A 12.3 10.9
A L1 macro  10.9 — A L2 19 13.6
A L2 |statisics 19 B L1 11.2 17.1
A L2 macro 13.6 B L2 8.2 14.7
B L1 [statistics| 11.2 © L1 12.8 135
B L1 macro = 17.1 c Lo 14.1 13.8
B L2 |[statistics| 8.2
B L2 macro 14.7
c L1 [statistics| 12.8
C L1 macro 13.5
C L2 |statisics 14.1
C L2 macro 13.8

b = pivot_wider(a, names_from = subject, values_from = mean)
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Application : Legislatives 2024

Utilisation de 3 bases de données:

e resultats au premier tour: resultats-definitifs-par-circonscription-tl.csv
e résultats au second tour: resultats-definitifs-par-circonscription-t2.csv
e population par circonscription en 2019: population_2019.csv

Chaque observation = une circonscription
Les bases de données des résultats aux élections sont en format wide:

e chaque circonscription a un nombre fini de candidats (jusqu'a 19 candidats)

 les informations relatives aux différents candidats (nom, sexe, parti politique, etc) sont renseignées dans différentes
variables

o les variables relatives au méme candidat ont le méme suffixe (eg Nom.candidatl, Nuance.candidatl, ...)
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Application : Legislatives 2024

< Encodage du libellé des circonscriptions

head(resultats t1[1:4,c(2,4)])

H# Libellé.département Libellé.circonscription.législative
H# 1 Ain lére circonscription
H# 2 Ain 2éme circonscription
H# 3 Ain 3éme circonscription
H# 4 Ain 4éme circonscription

head(pop_2019)[1:4, ]

H# X. Circonscriptions Population.20191IH.hab!.
Ho1 o1 Ain, 1re 122750
Ht 2 2 Ain, 2e 137975
Bt 3 3 Ain, 3e 146110
Bt 4 4 Ain, 4e 128896

Variables Clés: Libellé.département qui comprend uniquement le nom du département, et Libellé.circonscription qui
contient uniquement le numeéro de la circonscription.
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Application : Legislatives 2024

< Encodage du libellé des circonscriptions

resultats_tl = resultats_tl %>%
mutate(Libellé.circonscription.législative = gsub("H\D", ""  Libellé.circonscription.législative))

unique(resultats_t1$Libellé.circonscription.législative)

H# [1] "1" u2u u3u u4u u5u u6u u7u u8u u9u "10" "11" u12u u13u u14u u15u
H# [16] "16" ||17|| "18" ||19|| ||20|| ||21||

gsub ( "\\D” |, 7 , Libellé.circonscription.législative)
NS~ N—— ~ ~ ~~ =
remplace tout ce quin’est  Parune chafne dans la variable
pas numérique de caracteres vide Libellé.circonscription.législative
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Application : Legislatives 2024

< Encodage du libellé des circonscriptions

pop_2019 = pop_2019 %>%

separate(Circonscriptions, into = c("Libellé.département", "Libellé.circonscription.législative"), sep

mutate(Libellé.circonscription.législative = gsub("H\D", ""  Libellé.circonscription.législative))

unique(pop_2019¢$Libellé.circonscription.législative)

H# [1] "1" u2u u3u u4u u5u u6u u7u u8u u9u "10" "11" u12u u13u u14u u15u
H# [16] "16" ||17|| "18" ||19|| ||20|| ||21||

separate(” Circonscriptions” into =c(”A”,”B” Isep =",
)] )] 9 9

S O J/ J/
D' s Ve i
sépare les caracteres de la en deux chaines de caractéres  la séparation étant
variable Circonscriptions qui définissent ces deux variables faite a 'endroit de
la virgule

- n , n ) %>%
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Application : Legislatives 2024

1) Importer les données (nommer les dataframes resultats_t1, resultats_t2 et pop_2019)

2) Effectuer sur chaque jeu de données les opérations nécessaires pour harmoniser l'encodage du libellé de circonscription

e pop-19: separate(Circonscriptions, into = c("Libellé.département", "Libellé.circonscription.législative"), sep =
||' ||)
 resultats_t1 et resultats_t2 et pop_2019: gsub("H\D", "', Libellé.circonscription.législative)

3) Reformatter resultats_t1 et resultats_t2 en format long (chaque observation = un candidat)
4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

5) Ajouter les observations de resultats t2 a resultats_t1 et stocker le tout dans resultats

6) Ne conserver que les observations des candidats élus

7) Joindre pop_2019 a resultats et renommer Population.20191f. habf{. en pop
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Solution

1) Importer les données

resultats_tl1 = read.csv("data/resultats-definitifs-par-circonscription-tl.csv", sep = ";", na.strings=c("","NA"))
resultats_t2 = read.csv("data/resultats-definitifs-par-circonscription-t2.csv", sep = ";", na.strings=c("","NA"))
pop_2019 = read.csv("data/population_2019.csv", sep = ";")

2) Effectuer sur chaque jeu de données les opérations nécessaires pour harmoniser l'encodage du libellé de circonscription

resultats_tl = resultats_tl %>%

mutate(Libellé.circonscription.législative = gsub("H\D", "", Libellé.circonscription.législative))
resultats_t2 = resultats_t2 %>%
mutate(Libellé.circonscription.législative = gsub("H\D", "", Libellé.circonscription.législative))
pop_2019 = pop_2019 %>%
separate(Circonscriptions, into = c("Libellé.département", "Libellé.circonscription.législative"), sep = ", ") %>%
mutate(Libellé.circonscription.législative = gsub("H\D", "", Libellé.circonscription.législative))
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Solution

3) Reformatter resultats_t1 et resultats_t2 en format long

4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

resultats_tl long = resultats_tl %>%
pivot_longer(
cols = matches(".*j\.[1-91$|.%\.[11[0-91$"),

names_to = c(".value", "candidate_number"),
names_pattern = "(.%)\.(f\d+)"
) %>%

mutate(tour = 1)

Explication:

e cols = matches(".«}\.[1-91$].x\.[1]1[6-9]$"): Sélectionne les colonnes dont le nom termine par un point suivi d'un
nombre de 1a 19
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Solution

3) Reformatter resultats_t1 et resultats_t2 en format long

4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

resultats_tl long = resultats_tl %>%
pivot_longer(
cols = matches(".*j\.[1-91$|.x\.[11[0-91$"),

names_to = c(".value", "candidate _number"),
names_pattern = "(.%)\.(f\d+)"
) %>%

mutate(tour = 1)

Explications:

e names to = c(".value", "candidate number"): définie le nom des nouvelles variables
o .value crée de nouvelles variables dont le nom correspond a ce qui précede le point pour chaque variable ayant un

suffixe numerique
o candidate_number crée une nouvelle colonne qui contient les suffixes numériques (1 a 19) indiquant le numéro du

candidat
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Solution

3) Reformatter resultats_t1 et resultats_t2 en format long

4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

resultats_tl long = resultats_tl %>%
pivot_longer(
cols = matches(".*j\.[1-91$|.x\.[11[0-91$"),

names_to = c(".value", "candidate_number"),
names_pattern = "(.%)\.(f\d+)"
) %>%

mutate(tour = 1)

Explications:

 names_pattern = "(.%x)\.(§\d+)": utilise une expression réguliére pour séparer les noms de colonnes en deux parties:
o (.x) capture tout ce qui précede le point et l'assigne a .value
o (}\d+) capture les nombres apreés le point et les assigne a candidate_number
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Solution

3) Reformatter resultats_t1 et resultats_t2 en format long
4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

On reproduit les mémes opérations sur resultats_t2 (sauf que cette fois-ci il y a au maximum 4 candidats par
circonscription)

resultats_t2 long = resultats_t2 %>%
pivot_longer(
cols = matches(".*j\.[1-41$"),

names_to = c(".value", "candidate_number"),
names_pattern = "(.%)\.(f\d+)"
) %>%

mutate(tour = 2)
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Solution

5) Ajouter les observations de resultats t2 a resultats_tl et stocker le tout dans resultats
6) Ne conserver que les observations des candidats élus

7) Joindre pop_2019 a resultats et renommer Population.20191f. habfl. en pop

resultats = bind_rows(resultats_t1 long, resultats_t2_long) %>%
filter(Elu H= "elu") %>%
left_join(pop_2019 %>% rename(pop = Population.20191!l.hab!.), by = c("Libellé.département", "Libellé.circonscripti
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2. B rappels

2.5. Visualisation des données avec ggplot?

ggplot2

ggplot2 est un package R qui permet de visualiser des données sous forme de graphiques.

Afin de chainer des opérations, c'est a dire d'ajouter des couches au graphique, on utilise les + (l'équivalent de %>% avec
dplyr)

Pour consturire n'importe quel graphique, il faut:

e une base de données
o lier les variables aux élements graphiques (axes, couleurs, tailles) via l'argument aes()
o définir un type de graphique (ligne, point, histogramme, densité, etc)

Structure de base

ggplot(data,
aes(x = x, y = y)) +

geom_point()
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2. B rappels

2.5. Visualisation des données avec ggplot?

Principales fonctions

e ggplot() : Initialiser un graphique en spécifiant les donneées et les aesthetics
e geom_ : Représente les types de graphiques:

o geom_point() pour un nuage de points

o geom_line() pour des lignes

o geom_bar() pour un histogramme/barplot
o geom_density() pour une densité

e labs() :Ajouter des titres et legendes

e theme() : Personnaliser 'apparence du graphique
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2.8

2.5. Visualisation des données avec ggplot?

: rappels

Variable discrete

ggplot(

geom_
labs(
tit
X =
y
theme

resultats,

aes(x = Nuance.candidat)) +

bar() +

le = "Nombre de sieges par parti",
"Parti",

"Nombre de siéges") +
_minimal()

Nombre de sieges

Nombre de sieges par parti

150
100

50

0 ___IIIIIIIII___ ___IIIIIIIII e III

DIV DVC DVD DVG ECO ENS EXD HOR LR REG RN SOC UDI UG UXD
Parti
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2. B rappels

2.5. Visualisation des données avec ggplot?

Variable discrete

resultats %>% Proportion de siéges par parti

count(Nuance.candidat) %>%
mutate(percentage = n/sum(n)*100) %>%
ggplot(aes(x = Nuance.candidat,
y = percentage)) +
geom_bar(stat = "identity") +
labs(
title = "Proportion de sieges par parti",

30

N
o

x = "Parti",
y "Proportion de siéges") +
theme_minimal()

Proportion de sieges
o

La fonction count() compte le nombre d'observation par . __l-_ __I- A .

groupe Nuance.candidat et stocke cette information dans DIV DVC DVD DVG ECO ENS EXD HOR LR REG RN SOC UDI UG UXD

une nouvelle variable, n (équivaut a Parti

group_by(Nuance.candidat) %>% summarize(n = n()))
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2. B rappels

2.5. Visualisation des données avec ggplot?

Variable discrete

ggplot(resultats, Nombre de sieges par parti

aes(x = Nuance.candidat, fill = Sexe.candidat)) +

geom_bar() +
150

labs(
title = "Nombre de sieéges par parti", é
x = "Parti", :§100
y = "Nombre de siéges") + E
theme_minimal() + £
theme(legend.position="bottom") 3 50

0 _-.-_ _-l- e .

DIV DVC DVD DVG ECO ENS EXDHOR LR REG RN SOC UDI UG UXD
Parti

Sexe.candidat . FEMININ . MASCULIN
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2. B rappels

2.5. Visualisation des données avec ggplot?

Variable continue

resultats %>% Distribution des votes blancs

mutate(Blancs = as.numeric(Blancs)/100) %>%
ggplot(aes(x = Blancs)) +

geom_density() + 0.03
labs(
title = "Distribution des votes blancs",
x = "Votes blancs (en centaines)", 8 0.02
y = "Fréquence") + %
theme_minimal() 2
0.01
0.00

0 20 40 60
Votes blancs (en centaines)
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2. B rappels

2.5. Visualisation des données avec ggplot?

facet_wrap

resultats %>% Proportion de siéges par parti

group_by(Nuance.candidat) %>%

count(Sexe.candidat) %>% r
mutate(percentage = n/sum(n)*100) %>% 25 _- _-

ggplot(aes(x = Sexe.candidat,

y = percentage)) + éu;g

geom_bar(stat = "identity") + :g gg . -- . --
labs( g 0

title = "Proportion de sieges par parti", é-@g

x = "Parti", S 5 . -

y = "Proportion de siéges") + £ -- ] 1
facet_wrap( ~ Nuance.candidat) + o0 FEMINIMASCULIN
theme_minimal() s

FEMINIMASCULIN FEMINIMASCULIN FEMINIMASCULIN
Parti
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2. B rappels

2.6. Visualisation des données spaciales

Format de cartes et donnees

=
/N

[ Statiques J [ Dynamiques ]

Format de données
N\ (

Shapefiles Raster
J
\
sf raster
J
\
ggmap terra
J
\
terra
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2. B rappels

2.6. Visualisation des données spaciales

Format de cartes et donnees
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2. B rappels

2.6. Visualisation des données spaciales

Package sf
Shapefile: format de fichier geospatial utilisé pour représenter des entités geographiques

e contient des informations sur la forme (polygones, points, lignes) et des attributs.
e compose de plusieurs fichiers .shp, .shx, .dbf, tous nécessaires pour la réalisation de cartes

Une fois importes sur R, les objets sf sont des data.frame dont l'une des colonnes contient des geométries.

head(map[f],[]-<(5,6)1,3)

H#ESimpleIfeatureEcollectionlwithl3lfeaturesIandI4Ifields

Hillceometryfltype: [JMULTIPOLYGON

H#EDimension:IIIEEXY

H#fBoundingf]box: [J[jxmin:[]-0.595231fymin:[]44.80615[xmax: [|5.889757fymax:[{50.7899

H#EGeodeticECRS:EEWGSI84

feHHHHHRTolCode . départementficode_reginom_dpt{HHHHHHHHHHRHHHHHRERHecome try

bl 1[33004HHHRAHEERRREERR33HHAAEEE 75 G IRONDEIMULTIPOLYGONR( ((-0. 4549464,

bl 2[38001HHHAHHEERAHEERR 38R A8 4 HEH TSEREIMULTIPOLYGONR( ( (5. 80528845,

Hl3[)59010[AHRHRARARERERERS 2 BHRERER32 HRENORDMULTIPOLYGON( ( (3. 05874550 51/ 67




2. B rappels

2.6. Visualisation des données spaciales

Réaliser une carte en 3 étapes

1. Importer les données

o Lejeu de données qui contient l'information a visualiser
o Les fichiers shapefiles qui contiennent le fond de carte, etc, avec la fonction st_read()
o @:on importe sur R uniquement le fichier .shp, mais tous les autres fichiers (.shx, .dbf, etc) téléchargés avec le

shapefile doivent étre localisés au méme endroit que le .shp
2. Lier le jeu de données qui contient l'information a visualiser avec les donnéees geographiques

o Pour ajouter de l'information a un fond de carte, il est nécessaire de disposer d'une variable (key) géographique
commune entre les deux fichiers

3. Représenter la carte avec la fonction geom_sf() sur le méme principe que geom_line() par exemple avec ggplot2
o |ci, l'esthétique du graphique (aes ) comprend un nouvel argument, geometry, qui doit étre égal a la variable

contenant les données geographiques
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Application: carte resultats legislatives

Importer les données
1) Importer france-circonscriptions-legislatives-2012.shp, que vous stockerez dans maps

Cleaning

2) Renommer code_dpt en Code.département €t num_circ en Libellé.circonscription

3) Modifier la variable code.département: Sile premier caractére est un o, Code.département prend la valeur du deuxieme
caracere. Sinon pas de modification

Joindre les bases de données
4) Ajouter les informations de map a resultats et stocker le tout dans resultats_map

Reéaliser une carte

5) Réaliser la carte des résultats des éléctions législatives de 2024

NB: ne pas sélectionner les départements 971, 972, 973, 974, 975, 976, 986, 987, 988, ZX, ZZ qui correspondent aux DROM et qui ne
sont pas sur ce fond de carte
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Solution

Importer les données
1) Importer france-circonscriptions-legislatives-2012.shp, que vous stockerez dans maps

Cleaning
2) Renommer code_dpt en Code.département et num_circ en Libellé.circonscription
3) Modifier la variable code.département: si le premier caractére est un @, Code.département prend la valeur du deuxiéme

caracere. Sinon pas de modification

# Import data
map = st_read("data/france-circonscriptions-legislatives-2012.shp", quiet = TRUE) %>%
rename(Code.département = code_dpt,
Libellé.circonscription.législative = num_circ) %>%
mutate(Code.département = ifelse(substr(Code.département, 1, 1) = "0", substr(Code.département, 2, 2), Code.départ

54 [ 67



Solution

Importer les données
1) Importer france-circonscriptions-legislatives-2012.shp, que vous stockerez dans maps

Cleaning
2) Renommer code_dpt en Code.département et num_circ en Libellé.circonscription
3) Modifier la variable code.département: si le premier caractére est un @, Code.département prend la valeur du deuxiéme

caracere. Sinon pas de modification

# Import data
map = st_read("data/france-circonscriptions-legislatives-2012.shp", quiet = TRUE) %>%
rename(Code.département = code_dpt,
Libellé.circonscription.législative = num_circ) %>%
mutate(Code.département = ifelse(substr(Code.département, 1, 1) H= "0", substr(Code.département, 2, 2), Code.départ
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Solution

Importer les données
1) Importer france-circonscriptions-legislatives-2012.shp, que vous stockerez dans maps

Cleaning
2) Renommer code_dpt en Code.département €t num_circ en Libellé.circonscription
3) Modifier la variable code.département: si le premier caractére est un @, Code.département prend la valeur du deuxiéme

caracere. Sinon pas de modification

# Import data
map = st_read("data/france-circonscriptions-legislatives-2012.shp", quiet = TRUE) %>%

rename(Code.département = code_dpt,
Libellé.circonscription.législative = num_circ) %>%
mutate(Code.département = ifelse(substr(Code.département, 1, 1) = "0", substr(Code.département, 2, 2), Code.départ
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Solution

Importer les données
1) Importer france-circonscriptions-legislatives-2012.shp, que vous stockerez dans maps

Cleaning

2) Renommer code_dpt en Code.département et num_circ en Libellé.circonscription

3) Modifier la variable code.département : si le premier caractére est un 0, Code.département prend la valeur du deuxiéme
caracere. Sinon pas de modification

# Import data
map = st_read("data/france-circonscriptions-legislatives-2012.shp", quiet = TRUE) %>%
rename(Code.département = code_dpt,
Libellé.circonscription.législative = num_circ) %>%
mutate(Code.département = ifelse(substr(Code.département, 1, 1) = "0", substr(Code.département, 2, 2), Code.départ
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Solution

Joindre les bases de données
4) Ajouter les informations de map a resultats et stocker le tout dans resultats_map

# Merge geographic data and results data
resultats_map = resultats %>%
left_join(map , by = c("Code.département", "Libellé.circonscription.législative"))
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Solution

Réaliser une carte

5) Réaliser la carte des résultats des éléctions législatives de 2024

NB: ne pas sélectionner les departements 971, 972, 973, 974, 975, 976, 986, 987, 988, ZX, ZZ qui correspondent aux DROM et qui ne
sont pas sur ce fond de carte

# Draw map

ggplot(resultats_map %>% filter(! (Code.département %in% c("971", "972", "973", "974", "975", "976", "986", "987", "9
geom_sf(aes(fill = Nuance.candidat, geometry = geometry)) +
theme_minimal() +
scale_fill_manual(values = hcl.colors(14, "Purple-Yellow")) +

labs(title = "Résultats des élections législatives par circonscription”,
fill = "Parti") +
theme(legend.position = "bottom",

axis.text = element_blank(),

axis.ticks = element_blank(),

panel.grid = element_blank()) +
guides(fill = guide_legend(nrow = 1))
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Miscellaneous




Vos 4 meilleurs amis

1. La commande help(.) ou 2.
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Vos 4 meilleurs amis

1. La commande help(.) ou 2.
2. Les cheatsheets

o Exemple
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Vos 4 meilleurs amis

1. La commande help(.) ou 2.
2. Les cheatsheets

o Exemple

3. Internet (stackoverflow):

o VOUS ne serez jamais la premiere personne a rencontrer les problemes auxquels vous faites face
o copier/coller le message d'erreur peut suffire, mais essayez de comprendre par vous méme d'abord
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Vos 4 meilleurs amis

1. La commande help(.) ou 2.
2. Les cheatsheets

o Exemple

3. Internet (stackoverflow):

o VOUS ne serez jamais la premiere personne a rencontrer les problemes auxquels vous faites face
o copier/coller le message d'erreur peut suffire, mais essayez de comprendre par vous méme d'abord

4. ChatGPT: devient de plus en plus performant pour résoudre les problemes de codes.

o I souvent les packages ne sont pas a jour, les fonctions proposées inventees
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Vos 4 meilleurs amis

1. La commande help(.) ou 2.
2. Les cheatsheets

o Exemple

3. Internet (stackoverflow):

o VOUS ne serez jamais la premiere personne a rencontrer les problemes auxquels vous faites face
o copier/coller le message d'erreur peut suffire, mais essayez de comprendre par vous méme d'abord

4. ChatGPT: devient de plus en plus performant pour résoudre les problemes de codes.
o I souvent les packages ne sont pas a jour, les fonctions proposées inventees

' Soyez autonomes: ne demander de l'aide a vos camarades (ou a moi) uniqguement aprés avoir demandé a vos 4 meilleurs
amis!
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Bonnes pratiques

Organisation du travail

Un dossier pour chaque projet de recherche et differents sous-dossiers pour:

Scripts

o un scripts par tache: cleaning, statistiques descriptives, anlayse empirique

Data

o .rds

Figures

(Admin)

o par exemple les documents relatifs a l'accés a une base de données
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Commenter son code pour soi...]

Tryingjtojunderstandiyourcodelfrom|

E.’\*

n

rsample
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.. et ses collégues]

Types of Headaches

Stress

F‘ ¥



Essayer de ne pas s'énerver’

'apprentissage de R est long et fastidieux, mais les

. rendements sont croissants!
given

error
message on r

[1]: R Memes For Statistical Fiends

"Oh,
it's just
an extra
parenthesis"

CAN'T FIND
ONE SINGLE
PARENTHESIS
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Appendix




Cheatsheets

e R Studio Environment

e All cheatsheets

66 / 67


https://rstudio.github.io/cheatsheets/rstudio-ide.pdf
https://posit.co/resources/cheatsheets/

~

RStudio IDE : : CHEATSHEET

Documents and Apps

Open Shiny, R Markdeown,
BIEX | knitr, Sweave, LaTeX, .Rd files
and more in Source Pane

Check  Render Choose Configure Insert
spelling output output render code  Publish
. format options  chunk toserver

O e e

VA e *hea - |5 -

1 Jurﬁ'ﬁté Jump Rui  Showfile Wisual
o previous tonext  code  outline  Editor

7 chunk  chunk [reverse
8 side)
i Run

all previous  Run this

2
13 ::é:';;o code chunks _.code ch_unk
or chunk .
Set knitr
iy chunk
] options

R arkdon §

Access markdown guide at
Help > Markdown Quick Reference
See reverse side far more on Visual Editor

RStudio recognizes that files named app.R,
server.R, ui.R, and global.R belong to a shiny app
S orind . O awd . 8 wmd -=
2 # - b tnagn - B

Ruii” Choose Publishto " Manage

3
5 app locationto shinyapps.io publish
6 view app  oOr server accounts

Package Development

Create a new package with
m File > New Project > New Directory > R Package

Eriabalin s svmioes v im ssvmonmb ot Zones et

Navigate Ope
backwards/ window

Source Editor

ninnew Save Findand Compileas Run
’ replace notebook  selected

Tab Panes Version

Importdata Historyof past Manage  View Rtuterials
withwizard  commandsto  external  memory . CO ntrO I.

fom:dards ) ‘code run/copy _.databases dsage - <= Turn on at Tools > Project Options > Git/SVN
JTE | A oo g EEED D . o : 5 B - (_5 O Added @ Modffied Untracked
& reponid < 6 appR < 8 scrigeh ] Envionman Witory  Comnactions B — O Deleted @ Renamed
Source on 5 L A “Run | "4 = Source - = Import Dataset - N 14508 - & List ~ | (-
o] L 4 e 8 “__. | 1c.m::..;..:a:m . 1 § Stage Commit  Push/Pull  View  Current
2 Re-run " Source With or Show file d = Cleart Seorch insid files:  stagedfiles toremote History branch
3 nrel \ or outlir oa save ear Search inside : < - =
previous code  wfout Echoor outline - e e T | s e
4 vor Cl i ce orks O : ol e ulld-
5 asalocal Job WO kSpJ.,(‘ H workspace warkspace environment ; : 5 - - =g
*‘? :]:"“’,"“m'_. ‘Multiple cursars/column selection Chaoose environment to display from Display objects Camianre -
5 “ppwsen3- with Alt + mouse drag. list of parent environments as list or grid Wi B Open shell to type commands
ERR - - Data ' " - -
g — Code diagnostics that appear in the margin. g ¢ 3 oa. of 2 varicbles Show file diff to view file differences
1 ... Hover over diagnostic symbols for details o]
12+ get_digit = fumttion() { -
i w) .. Syntax highlighting based —_ B
- 15 on your file's extension oo Anction O . . [
) S o ) L Sorn @ aped @ gt Gomre s 8] Ve ¢ I
... Tab completion ta finish function Displays saved objects by View indata View function e T e e
18 fo names, file paths, arguments, and more.  type with short description viewer source code o
o DR ;i s B | Th ki o, Yo i i £ apidaticn by dliihng
0 for b Files  Plats  Packages Help  Viewsr =0
2 Lo force “Multi-language code snippets to QNewroker O Delete 4 Rename g More -
3 quickly use common blocks of code @ Home > Desbiop > aps e ile % Debug M Ode
s " options  fedined 3
PRI ) ; wem. OPiONs .
3 JL!ITI[I to function in file Change file type Create | Delate Rename Copy Febde P o Chpant Change Use debug(), browser(), or 2 breakpoint and execute
L1 (Top Lewsl £ RS folder : file file —— directory your code to open the debugger mode.
Consohy | Termioal x | R Merkdown ¥ | Jobs Path to displayed directory m— Launch debugger  Open traceback to examine
® K410 - </Duskiopiopo] . - 5 spni PR | 10, 2021, 6.21 P mode from origin~ the functions that R called
s ‘Working ™. Runscriptsin Maximize, B app Roro) 3038 i 10,2000, 451 of error before the error occurred
Directory ™. separate sessions  minimize panes , _ - - i
R Y ., par ! i A File browser keyed to your working directory. Console  Terminal = “ipbs H =0
L‘a‘»ﬁr ‘Itwp;) ~Ctrl/Cmd +4 “R Markdown  Drag pane ......... Clickon file or directory name to open. > helloQ) N E
§ ’ to see history  Build Log boundaries E—
. . o . Click next to line numberto  Highlighted line shows where
RStudio opens plots in 2 dedicated Plots pane RStudio opens documentation in a dedicated Help pane add/remove a breakpoint. execution has paused
Foes  Fou  Pakages  Help  Viemer -0 flew Flois  Fackagas el Viewss =] i EL—
. Pom Bege. 0. B Putiish - F Refrash Help Toie
Navigate “Openin ~Export  Delete " Delete e e, |
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